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Zdjęcia są własnością autora. Mogą być wykorzystywane wyłącznie 
niekomercyjnie w ramach zajęć dydaktycznych z przedmiotu: Techniki 
multimedialne w promocji i informacji turystycznej (w programie 
studiów 2-go stopnia na kierunku Turystyka i Rekreacja na Wydziale 
GGiOŚ AGH). 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

I. Zdjęcia nocne 
 
Fig. 1. Zakład przyrodoleczniczy Wojciech w Lądku Zdroju, ISO 100, f/14, 28 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 
 

1. Co do zmiany? 

a) zły WB od lamp oświetlających schody i deptak, 

b) zbyt ciemna elewacja budynku, 

c) spore niedoświetlenie tła (noc) oraz prześwietlenie fragmentów elewacji od świateł o 

wyraźnie innej temperaturze barwowej niż lampy oświetlające deptak, 

d) ogólne modyfikacje, wyostrzanie, redukcja szumów. 

2. Modyfikacje: 

 WB –> custom -> Temp = 2230 (poprawa WB w rejonie schodów, niestety światła na elewacji 

zmieniły swe zabarwienie na wyraźnie niebieski odcień – pozbędziemy się tego niżej). 

 Tone -> Auto (pozbywamy się wyraźnego niedoświetlenia w tle). 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Spróbujemy (na ile to możliwe) pozbyć się lub zmniejszyć prześwietlenia frontowych 

fragmentów budynku oświetlonych zamontowanymi na elewacji lampami kinkietowymi: 

Recovery -> 75. 

 Zdjęcie sprawia wrażenie mało kontrastowego, wymaga niewielkiej modyfikacji kontrastu, 

który da także efekt większej ostrości: Contrast -> 14. 

 W celu usunięcie niewielkiej mgiełki, mętności na zdjęciu, powinniśmy zmodyfikować 

przejrzystość (Clarity). Modyfikacja polega na polega na zwiększeniu kontrastu półcieni: 

Clarity ->24. Zdjęcia po modyfikacji przejrzystości zyskują zawsze na ostrości. Poprawna 

korekcja w większości przypadków powinna polegać na zwiększeniu wartość do ok. +25 lub 

nawet +50. Nie powinno się korygować in „+” jedynie tych fotografii, które ze względu na ich 

kompozycję lub sposób ujęcia tematu powinny być bardzo nastrojowe i mniej kontrastowe 

(np. portrety dzieci lub portrety typu glamour). 

 W celu poprawy ogólnej intensywności kolorów, można w niewielkim zakresie poprawić 

parametr Saturation -> 6. Działanie tego narzędzia posiada pewną wadę co prawda poprawia 

intensywność barw mdłych i niewyraźnie zaznaczonych, ale niejako przy okazji zostaną 

zmodyfikowane także i te, które były już pierwotnie nasycone. Staną się wtedy 

zdecydowanie zbyt intensywne, a zdjęcie będzie wyglądało nienaturalnie. Ze względu na 

dość stonowany charakter kompozycji, proponuję postąpić nieco bardziej subtelnie i 

skorzystać z narzędzia Vibrance (intensywność). Zastosowanie go również powoduje 

zwiększanie nasycenia barw, ale zmodyfikowane zdjęcia wyglądają znacznie bardziej 

naturalnie. Algorytm działania tego suwaka sprawia, że mdłe, spłowiałe kolory stają się 

znacznie intensywniejsze, zaś te, które były żywe i wyraziste, są traktowane znacznie 

łagodniej. Poza tym, algorytm został opracowany w taki sposób, by w możliwie niewielkim 

stopniu wpływał na kolorystykę skóry. Vibrance -> 13. 

 Zakres tonalny zdjęcia wydaje się w porządku i nie wymaga poważnych modyfikacji krzywej 

tonalnej. Można co najwyżej spróbować wyciągnąć przepalenia na elewacji. W tym celu 

kliknij na narzędzie wyboru fragmentu zdjęcia, którego tony chcemy zmodyfikować, a 

następnie obniżymy Highlight Tones -> -65. 

 Przechodzimy do precyzyjnej modyfikacji kolorów HSL (Hue - odcień, Saturation - nasycenie, 

Luminance - jasność). Po pierwsze musimy się pozbyć nienaturalnego niebieskiego światła na 

elewacji budynku. Luminance -> Blue -> 55, Saturation -> Blue -> -45. 

 Przechodzimy do zakładki Detail, w której spowodujemy wyostrzenie zdjęcia: Sharpening -> 

Amount -> 62. Warto przy tym powiększyć zdjęcie i dokonywać niezbędnych modyfikacji na 

podstawie widoku 1:1. 

 W tej samej zakładce (Detail), przechodzimy do narzędzia odszumiającego Noise Reduction. 

Zdjęcie zostało wykonane z czułością ISO 100 i szum który dobrze jest widoczny w 

powiększeniu (zwłaszcza 3:1), jest efektem długiego naświetlania i słabej jakości matrycy 

aparatu. Luminance -> 14. 

 Na koniec pozbędziemy się niepożądanych zniekształceń optycznych wynikających z 

niedoskonałości obiektywu. W module Library->Metadata->EXIF, możemy sprawdzić jakim 

obiektywem zostało zrobione zdjęcie. W tym przypadku jest to obiektyw 17-50mm f/2.8 

firmy Tamron. Przechodzimy do zakładki Lens Correction -> zaznaczamy opcję: Enable Profile 

Correction, Lens Profile -> Make -> Tamron, Model -> Tamron SP 17-50 F/2.8 DiII A16N. 

Zaznaczone opcje spowodują niewielką modyfikację geometrii zdjęcia. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Ostatnią rzeczą wymagającą zmiany jest rozjaśnienie dachu kopuły budynku. Dokonamy tego 

za pomocą narzędzia pędzla (Adjustment Brush) znajdującego się bezpośrednio pod 

histogramem (ostatnia ikona). Klikamy na pędzel po czym dość dokładnie „zamalowujemy” 

kopułę. Po zamalowaniu całości wybieramy Effect -> Custom, Exposure -> 1.56. W zależności 

od dokładności zamalowania kopuły, efekt może się nieco różnić od zamieszczonego poniżej. 

 Za pomocą „prawokliku” eksportujemy jpg. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

II. Zdjęcia krajobrazowe z dużym udziałem chmur 
 

Fig. 2. Widok z Góry Św. Anny w kierunku północnym. W tle Góry Sowie, w dolinie Nowa Ruda, ISO 
100, f/22, 1/4 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 
 

1. Co do zmiany?: 

a) mały kontrast, 

b) zbyt chłodna kolorystyka i wypłowiała, 

2. Modyfikacje: 

 WB –> custom -> Temp = 5330 (ocieplenie kadru). 

 Tone -> Auto (zdjęcie zyskuje na kontraście). 

 Pozbywamy się przepaleń na jasnych stropach chmur: Recovery -> 13. 

 W celu poprawy zbyt dużego kontrastu, modyfikujemy ilość światła wypełniającego: Fill Light 

-> 17. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Pod pasem drzew, na skraju polany widoczny jest ostry cień, na którym utraciliśmy 

szczegóły, spróbujmy nieco rozjaśnić ten cień poprzez redukcję: Blacks -> 7. 

 Niestety poprzednie poprawki spowodowały redukcję kontrastu. Poprawiamy go: Contrast -> 

62. 

 W celu usunięcie mgiełki atmosferycznej, musimy zmodyfikować przejrzystość: Clarity ->20. 

Uzyskany efekt najlepiej obserwować w drugim planie (np.: szczyty gór). Zdjęcie zyskuje na 

kontraście i trochę na ostrości. 

 Nieznacznie poprawiamy intensywność nieintensywnych barw: Vibrance -> 10, 

 a także intensywności kolorów w ogólności: Saturation -> 8. Zmiana najbardziej widoczna 

jest na zieleni trawy i błękicie nieba. 

 Przechodzimy do modyfikacji krzywej tonalnej, na której zmieniamy jasność półtonów: Tone 

Curve -> Region -> Shadows -> 39. 

 Przechodzimy do precyzyjnej modyfikacji kolorów HSL (Hue - odcień, Saturation - nasycenie, 

Luminance - jasność). Z powodu nieciekawej kompozycji centralnej, powinniśmy podkreślić 

znaczenie nieba poprzez modyfikację jasności koloru niebieskiego (przyciemnienie): 

Luminance -> Blue -> -11. 

 Niestety z lewej strony zdjęcia, tuż nad poziomem cumulusów wyraźnie widoczne są dwa 

artefakty w postaci niewielkich szarych plamek. Ich pojawienie się na zdjęciu związane jest z 

wysoką wartością przysłony (f/22) i jest efektem zabrudzenia matrycy aparatu (wymaga 

przedmuchania gruszką lub przeczyszczenia). Pozbędziemy się ich za pomocą narzędzia: Spot 

Removal (druga ikona od lewej, pod histogramem). Wybieramy: Spot Edit -> Clone, Size -> 30 

(wielkość koła narzędzia), Opacity -> 100 (pokrycie). W następnym kroku klikamy najpierw w 

centrum pierwszej plamki, później na drugą. 

 Po usunięciu artefaktów, powracamy do modyfikacji barw. Podniesiemy nasycenie zieleni: 

Saturation -> Green -> 30, i jeszcze taka sztuczka powodująca nabranie przez trawę soczystej 

barwy: Saturation -> Yellow -> 16. 

 W celu ocieplenia kadru dodajmy jeszcze nasycenia barwie pomarańczowej: Saturation -> 

Orange -> 16. 

 Przechodzimy do zakładki Detail, w której wyostrzymy zdjęcie: Sharpening -> Amount -> 90. 

Warto przy tym powiększyć zdjęcie i dokonywać niezbędnych modyfikacji na podstawie 

widoku 1:1. 

 W tej samej zakładce (Detail), przechodzimy do narzędzia odszumiającego Noise Reduction. 

Zdjęcie zostało wykonane z czułością ISO 100 i szum który dobrze jest widoczny w 

powiększeniu (zwłaszcza 3:1), jest głównie efektem dokonanych do tej pory modyfikacji. 

Luminance -> 17. 

 Tym razem nie będziemy modyfikować zniekształceń optycznych ale sprawdźmy jakim 

obiektywem było robione zdjęcie (moduł Library->Metadata->EXIF). W tym przypadku jest to 

obiektyw zoom 18-135mm f/3.5-5.6 firmy Nikkor. 

 Ostatnią rzeczą, którą chciałbym zmodyfikować to poprawa nieba z chmurami. Zajmiemy się 

poprawą kontrastu i wyrazistości chmur. Aby zmiany odniosły skutek dla całego nieba, a 

podłoga pozostała bez poprawek, zastosujemy Graduated Filter ( filtr stopniowy), dostępny 

poprzez czwartą ikonę od lewej, pod histogramem. Klikamy na to narzędzie po czym 

przeciągamy je z góry na dół od krawędzi zdjęcia po granicę horyzontu. Starajmy się jednak 

zachować poziomy charakter filtra. Po przeciągnięciu zmodyfikujmy kolejno opcje filtra: 

Effect -> Custom, Contrast -> 66, Saturation -> 2, Clarity -> 24, Sharpness -> 32. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Eksportujemy jpg. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

III. Zdjęcia krajobrazowe z silnym efektem mgiełki atmosferycznej 
 

 
Fig. 3. Widok z masywu Lovcen na Zatokę Kotorską (Czarnogóra). W dole miasto Kotor, ISO 100, 
f/10, 1/30 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 
 

1. Co do zmiany?: 

a) fatalna mgiełka atmosferyczna pozbawiająca kadr jego siły tkwiącej w niepowtarzalnym 

widoku, 

b) zbyt chłodna i wypłowiała kolorystyka, 

c) brak kontrastu, 

d) utrata atutu ciekawych chmur na horyzoncie. 

2. Modyfikacje: 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Jeżeli to konieczne, zmodyfikujmy: Update to Current Process (2010) (ikonka w prawym, 

dolnym rogu zdjęcia). 

 WB –> custom -> Temp = 5793 (ocieplenie kadru). 

 Tone -> Auto (zdjęcie ulega przyciemnieniu, zyskuje jednak na kontraście i wyrazistości 

kolorów). 

 Z powodu przyciemnienia kadru będącego efektem poprzedniej modyfikacji, zaistniała 

potrzeba rozjaśnienia klatki: Fill Light -> 38. 

 W celu poprawy kontrastu, modyfikujemy: Contrast -> 84. 

 W celu usunięcie mgiełki atmosferycznej i poprawy plastyczności zdjęcia, musimy 

zmodyfikować przejrzystość: Clarity ->29. Niestety z narzędziem Clarity nie można 

przesadzać. Nadmierna modyfikacja parametru spowoduje zmianę kolorystyki na 

nienaturalną typu plakatowego. 

 Nieznacznie poprawiamy intensywność nieintensywnych barw: Vibrance -> 49. Zdjęcie 

zyskuje mocno niebieski odcień, który trochę równoważy intensywnie żółta, przepalona 

słońcem trawa. W następnych krokach zmuszeni będziemy pozbyć się nadmiaru tych barw. 

 W tym celu zmniejszmy nasycenie barw: Saturation -> -20. Jest znacznie lepiej, jeszcze tylko 

ta dominanta niebieskiego koloru. 

 Przechodzimy do precyzyjnej modyfikacji kolorów HSL. Modyfikujemy jasność koloru 

niebieskiego (przyciemnienie). Luminance ->Blue -> -23. 

 Przechodzimy do zakładki Detail, w której wyostrzymy zdjęcie: Sharpening -> Amount -> 69. 

Jak zwykle, warto przy tym powiększyć zdjęcie i dokonywać niezbędnych modyfikacji na 

podstawie widoku 1:1. 

 W tej samej zakładce (Detail), przechodzimy do narzędzia odszumiającego Noise Reduction. 

Zdjęcie zostało wykonane z czułością ISO 100 i szum który dobrze jest widoczny w 

powiększeniu (zwłaszcza 3:1), jest efektem postprocesingu. Luminance -> 11. Zbyt wysoka 

wartość tego parametru powoduje nienaturalne „wygładzenie” zdjęć i jest bardzo 

niekorzystna. 

 Kolejną modyfikacją będzie poprawa nieba z chmurami. Nasze zadanie to poprawa kontrastu 

i wyrazistości chmur. Aby zmiany odniosły skutek dla całego nieba, a podłoga pozostała bez 

poprawek, zastosujemy Graduated Filter ( filtr stopniowy), dostępny poprzez czwartą ikonę 

od lewej, pod histogramem. Klikamy na to narzędzie po czym przeciągamy je z góry na dół 

od krawędzi zdjęcia po granicę horyzontu. Starajmy się jednak zachować poziomy charakter 

filtra. Po przeciągnięciu zmodyfikujmy kolejno opcje filtra: Effect -> Custom, Exposure -> -0.1, 

Brightness -> 5, Contrast -> 58, Saturation -> 19, Clarity -> 17, Sharpness -> 17. 

 Ostatnią, potrzebną modyfikacją sceny będzie pozbycie się zbędnego, odwracającego uwagę, 

pierwszoplanowego elementu, jakim jest fragment drewnianej barierki lub ławki. Zadanie to 

wykonane zostanie przy użyciu narzędzia: Spot Removal (druga ikona od lewej, pod 

histogramem). Wybieramy: Spot Edit -> Clone, Size -> 86 (wielkość koła narzędzia), Opacity -

> 100 (pokrycie). Potrzebne będą dwa kliknięcia. Należy zadbać o to aby stęplowana wartość 

ładnie i naturalnie komponowała się z pozostałą częścią zdjęcia. 

 Za pomocą „prawokliku” eksportujemy jpg. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

IV. Zdjęcia w jaskiniach w sztucznym świetle zastanym 
 

 
Fig. 2. Jaskinia Niedźwiedzia w Kletnie. Sala, ISO 100, f/13, 18 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 
 

1. Co do zmiany?: 

a) fatalna balans bieli wynikający z nietypowego, nowoczesnego oświetlenia jaskini za pocą 

diod LED, 

b) rozjaśnienie niedoświetlonych fragmentów zdjęcia, 

2. Modyfikacje: 

 Jeżeli to konieczne, modyfikujemy: Update to Current Process (2010) (ikonka w prawym, 

dolnym rogu zdjęcia). 

 Zmieniamy WB na predefiniowany: WB –> Tungsten (jaskinia nabiera właściwych barw). 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Tone -> Auto (zdjęcie ulega zbytniemu rozjaśnieniu, a w części centralnej nawet przepaleniu. 

W niektórych fragmentach zdjęcia tracimy szczegóły. 

 Jesteśmy zmuszeni do ręcznej modyfikacji ekspozycji: Exposure -> -0.23. 

 Z powodu niewielkiego przyciemnienia kadru będącego efektem poprzedniej modyfikacji, 

istnieje potrzeba rozjaśnienia klatki: Fill Light -> 44. 

 Nieznacznie poprawiamy kontrast: Contrast -> 55. 

 W zdjęciach o dużej ilości szczegółów – głównie architektura, ale także w tym przypadku 

warto zmodyfikować przejrzystość (25-75). Tutaj: Clarity -> 31. 

 Nieznacznie poprawiamy intensywność nieintensywnych barw: Vibrance -> 15. Zdjęcie 

delikatnie zyskuje na intensywności barw. Jaskinie nie są specjalnie kolorowe, więc 

rezygnujemy z użycia narzędzi Saturation i HSL. 

 Przechodzimy do zakładki Detail i dość radykalnie wyostrzymy zdjęcie: Sharpening -> 

Amount -> 59. 

 Przechodzimy do narzędzia Noise Reduction. Zdjęcie zostało wykonane z czułością ISO 100. 

Szum, który dobrze jest widoczny w ciemniejszym fragmencie zdjęcia, jest efektem długiej 

ekspozycji i w mniejszym stopniu postprocesingu. Luminance -> 10.  

 Eksportujemy jpg. 

 

  



 

Techniki multimedialne w promocji i informacji turystycznej 
 

R
o

zd
zi

ał
: Z

d
ję

ci
a 

kr
aj

o
b

ra
zo

w
e 

w
 o

st
ry

m
 ś

w
ie

tl
e 

„w
 s

am
o

 p
o

łu
d

n
ie

” 

 

  
 

T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

V. Zdjęcia krajobrazowe w ostrym świetle „w samo południe” 
 

 
Fig. 2. Wyspa Św. Stefana (Czarnogóra), ISO 320, f/18, 1/40 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 

 

1. Co do zmiany?: 

a) Krzywy horyzont, 

b) nic nie wnoszące ½ zdjęcia w suficie, 

c) brak kontrastu, 

d) niewielkie niedoświetlenie kadru, 

e) niewielka mgiełka atmosferyczna, 

f) słaba intensywność barw. 

2. Modyfikacje: 

 Jeżeli to konieczne, zmodyfikujmy: Update to Current Process (2010) (ikonka w prawym, 

dolnym rogu zdjęcia). 

 W celu wyprostowania zdjęcia klikamy na narzędzie: Crop Overlay. Zmieniamy kąt zdjęcia 

Angle -> -1.19. 

  W kolejnym kroku będziemy przycinać górną część zdjęcia. Domyślnie kadrowanie zdjęć 

odbywa się w sposób proporcjonalny, poprzez przeciągnięcie krawędzi zdjęcia do 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

pożądanych wymiarów. Aby umożliwić nieproporcjonalną modyfikację proporcji zdjęcia, 

zmuszeni jesteśmy zwolnić blokadę proporcji. Symbolizuje ją mała kłódka znajdująca się  z 

prawej strony zakładki narzędzia Crop & Straighten. Po odblokowaniu, przeciągamy górną 

krawędź zdjęcia do takiego poziomu aby wyspa znajdowała się centrum kadru. 

 Dokonujemy nieznacznej modyfikacji WB –> Custom -> Temp = 5103 (ocieplenie kadru). 

Zyskujemy przy okazji zmianę koloru wody na lekko lazurową.  

 Tone -> Auto (pozbywamy się znacznej ilości półtonów). Zdjęcie zyskuje na przejrzystości. 

 Z powodu lekkiego prześwietlenia grobli prowadzącej na wyspę, próbujemy wyciągnąć 

światła: Recovery -> 22. 

 Aby nieco rozjaśnić kadr stosujemy: Fill Light -> 11. 

 Pozbędziemy się także nieco niedoświetleń występujących w głębokich cieniach: Blacks -> 8. 

 Poprawiamy nieznacznie kontrast: Contrast -> 60. 

 Poprawiamy przejrzystość zdjęcia: Clarity -> 24. 

 Nieznacznie poprawiamy intensywność barw za pomocą: Vibrance -> 10. Oraz: Saturation -> 

3. 

 Zdjęcie wygląda całkiem w porządku. Można się jednak pokusić o drobne modyfikacje 

najważniejszych kolorów. Przechodzimy do precyzyjnej modyfikacji kolorów HSL. 

Modyfikujemy jasność koloru niebieskiego (przyciemnienie): Luminance -> Blue -> -14. 

Radykalnie rozjaśniamy lazurowy kolor wody przy brzegu: Luminance -> Aqua -> 93. 

Nieznacznie rozjaśniamy barwę dachówek: Luminance -> Orange -> 9. Silnie rozjaśniamy 

zieleń drzew: Luminance -> Green -> 55. 

 Nie ma potrzeby modyfikacji krzywej tonalnej. 

 Przechodzimy do zakładki Detail i mocno wyostrzamy zdjęcie: Sharpening -> Amount -> 71. 

 Przechodzimy do odszumiania - Noise Reduction. W związku z tym, że zdjęcie zostało 

wykonane z czułością ISO 320, zawiera dużą ilość szumu (typowe dla Nikon D80) - patrz 

powiększenie. W związku z powyższym istnieje potrzeba bardziej radykalnego niż zwykle 

odszumienia kadru: Luminance -> 30. 

 Eksportujemy jpg. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

VI. Prostowanie geometrii zdjęć robionych obiektywami 

szerokokątnymi 
 

 
Fig. 2. Meczet w Stari Bar (Czarnogóra), ISO 320, f/14, 1/50 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 
 

1. Co do zmiany?: 

a) wyprostowanie wieży lewego minaretu, 

b) nieznaczne ocieplenie zdjęcia, 

c) niewielkie modyfikacje kolorów 

2. Modyfikacje: 



 

Techniki multimedialne w promocji i informacji turystycznej 
 

R
o

zd
zi

ał
: P

ro
st

o
w

an
ie

 g
eo

m
et

ri
i z

d
ję

ć 
ro

b
io

n
yc

h
 o

b
ie

kt
yw

am
i s

ze
ro

ko
ką

tn
ym

i 

 

  
 

T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

 Jeżeli to konieczne, zmodyfikujmy: Update to Current Process (2010) (ikonka w prawym, 

dolnym rogu zdjęcia). 

 Na wstępie należy pozbyć się niewielkiej szarej plamki (artefakt) widocznej przy lewej 

krawędzi zdjęcia. Wybieramy narzędzie: Spot Removal, dobieramy wielkość koła narzędzia: 

Size -> 48, Opacity -> 100 i stemplujemy plamkę. 

 Dokonujemy nieznacznej ocieplenia WB. Wybieramy predefiniowany WB -> Daylight. Obraz 

zyskuje na delikatnym ciepłym zabarwieniu. 

 Tone -> Auto (pozbywamy się znacznej ilości półtonów). Rośnie kontrast. Zdjęcie zyskuje na 

przejrzystości. 

 Otwieramy teraz narzędzie znajdujące się w zakładce: Lens Correction. Zaznaczamy Enable 

Profile Correction -> Manual. Wybieramy suwak: Transform -> Vertical -> -26, Distorsion -> -

17 oraz Rotate -> -1.3. Zdjęcie wydaje się wyprostowane. Niestety następstwem każdego 

prostowania jest utrata fragmentów zdjęcia w rejonie narożników (w tym przypadku 

dolnych). Zmusi nas to w pewnym momencie do odpowiedniego wykadrowania i przycięcia 

zdjęcia. 

 Poprawiamy nieznacznie kontrast: Contrast -> 69. 

 Poprawiamy przejrzystość zdjęcia: Clarity -> 33. 

 Nieznacznie poprawiamy intensywność barw za pomocą: Vibrance -> 20. 

 Zdjęcie wygląda dobrze. Zmodyfikujemy tylko kolor nieba, zieleni i pomarańczy w tle skał.  

Przechodzimy do precyzyjnej modyfikacji kolorów HSL. Modyfikujemy jasność koloru 

niebieskiego: Luminance -> Blue -> -16. Podkręcamy nieco żółtą barwę, która sprawi, że 

zieleń będzie nieco żywsza: Luminance -> Yellow -> -27. Nieznacznie przyciemniamy barwę 

zwietrzeliny skał: Luminance -> Orange -> -23. 

 Nie ma potrzeby modyfikacji krzywej tonalnej. 

 Przechodzimy do zakładki Detail i dość mocno wyostrzamy zdjęcie: Sharpening -> Amount -> 

59. 

 Przechodzimy do odszumiania - Noise Reduction. W związku z tym, że zdjęcie zostało 

wykonane z czułością ISO 320, zawiera dużą ilość szumu (typowe dla Nikon D80) - patrz 

powiększenie. Istnieje konieczność odszumienia kadru: Luminance -> 31. 

 Za pomocą narzędzia Crop Overlay (druga ikona od lewej pod histogramem) kadrujemy 

proporcjonalnie zdjęcie. 

 Eksportujemy jpg. 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

VII. Zdjęcia w muzeach i przy sztucznym świetle zastanym 
 

 

Fig. 2. Rekonstrukcja szkieletu niedźwiedzia jaskiniowego w pawilonie wystawowym przy wejściu do 
jaskini Niedźwiedziej w Kletnie (Kotlina Kłodzka), ISO 100, f/20, 3 sek., fot.: T. Bartuś 

 
RAW (przed obróbką) 

 

 
jpg (po obróbce) 

 

 

1. Co do zmiany?: 

Zdjęcie zostało wykonane w bardzo trudnych warunkach oświetleniowych w świetle 

zastanym. Pawilon wystawowy, poprzez wysoko umieszczone okna, oświetlany jest światłem 

naturalnym. Niestety nie jest go zbyt wiele. Witryny wystawiennicze umieszczone w szklanych 

gablotach posiadają swoje sztuczne oświetlenie. Stanowi je wielopunktowe oświetlenie oparte 

na diodach LED. Zdjęcie robione było na statywie, a czas naświetlenia wynosił aż 3 sek. Sytuację 
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T. Bartuś, Obróbka zdjęć w Adobe Lightroom 3.2 

dodatkowo utrudniały refleksy światła powstające na szybie witryny. Zdjęcie było robione bez 

użycia filtra polaryzacyjnego. Automatyczny WB nieco się w tej sytuacji pogubił. Drugoplanowe 

tło oświetlone światłem naturalnym uzyskało wyraźnie niebieskawe zabarwienie. Szkielet 

niedźwiedzia jaskiniowego, z powodu długiego czasu naświetlania uzyskał intensywnie 

pomarańczową barwę. Podstawowym zadaniem postawionym sobie przed obróbką będzie: 

a) poprawienie balansu bieli, 

b) korekcja zbyt intensywnej, pomarańczowej poświaty od światła sztucznego, 

c) ogólne rozjaśnienie zdjęcia. 

2. Modyfikacje: 

 Jeżeli to konieczne, zmodyfikujmy: Update to Current Process (2010) (ikonka w prawym, 

dolnym rogu zdjęcia). 

 Dokonujemy korekcji WB. Wybieramy narzędzie White Balance Selector (ikonka z pipetą 

znajdująca się w zakładce: Basic -> WB). Szukamy miejsca o barwie ciemno-szarej 

(współczynnik odbicia światła 18%). Oczywiście program nie podpowie nam który piksel ma 

takie zabarwienie. To my musimy zdecydować, który uznamy za 18%-ową szarość i reszta 

pikseli zostanie skorygowana do tego wzorca. Proponuję wybrać miejsce znajdujące się na 

ciemno-szarej framudze u podstawy witryny. W moim przypadku, wybrany piksel 

zmodyfikował WB: Temp -> 7550, Tint -> +28. 

 Tone -> Auto. Zdjęcie ulega nieco rozjaśnieniu. Rośnie też kontrast zdjęcia i przejrzystość. 

 W związku z tym, że autoregulacja ekspozycji nie spowodowała wystarczającego rozjaśnienia 

kadru i klatka cały czas jest niedoświetlona, musimy użyć narzędzia: Fill Light -> 22. 

 Poprawiamy kontrast: Contrast -> 67. 

 Poprawiamy przejrzystość zdjęcia: Clarity -> 31. 

 Aby pozbyć się nadmiaru intensywność barw, ujmujemy nieco nasycenia: Vibrance -> -13. 

 Zdjęcie ciągle jest dość ciemne. Możemy je jeszcze trochę rozjaśnić przy użyciu krzywych 

tonalnych. Wybieramy narzędzie: Tone Curve -> Adjust Tone Curve by dragging in the photo. 

Wybieramy jakieś szare, ciemne miejsce znajdujące się w zacienionym drugim planie  i bez 

zwalniania lewego przycisku myszy, w celu rozjaśnienia cieni przeciągamy kursor, aż do 

uzyskania pożądanego efektu w górę. Wymagany efekt można też uzyskać drogą wpisania 

obok suwaka Darks wartości +13.  

 Zdjęcie wygląda nieźle chociaż ciągle w pierwszym planie dominuje pomarańczowe światło 

sztucznego oświetlenia ekspozycji. Ta intensywna barwa wynika ze źle dobranej temperatury 

barwowej tego źródła światła (WB). Zmodyfikujemy tylko kolor pomarańczowy. 

Przechodzimy do precyzyjnej modyfikacji kolorów HSL. Radykalnie modyfikujemy nasycenie 

koloru pomarańczowego: Saturation -> Orange -> -52. 

 Przechodzimy do modyfikacji odcieni Hue i modyfikujemy balans pomiędzy kolorami żółtym i 

pomarańczowym: Hue -> Orange -> +11. 

 Przechodzimy do zakładki Detail i mocno wyostrzamy zdjęcie: Sharpening -> Amount -> 78. 

 Przechodzimy do odszumiania - Noise Reduction. W związku z tym, że zdjęcie zostało 

wykonane z czułością ISO 100, zawiera niewielką ilość szumu. Wystarczy zatem kosmetyczna 

korekcja: Luminance -> 15. 

 Eksportujemy jpg. 

 


